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1 INTRODUCTION 

This document covers the operation of the Sensor Evaluation Tool software and should be used in conjunction 

with the SMD Sensor Reference Manual. 

The software can be used to test up to four single-pixel sensors or one 2x2 array sensor. It enables you to 

optimise the sensor for a particular environment, observe signals in real time and to experiment with register 

settings, optimising: 

• gain 

• filtering (HPF, LPF, transconductance) 

• sample rate 

• clk/sync for device synchronisation 

• interrupt enable / disable 

• wake up (WUP) 

Register settings can be saved to, and loaded from, a text file. Please refer to Section 7 for details. 

2 GETTING STARTED 

2.1 Installing the Sensor Evaluation Tool 

Download the latest Sensor Evaluation Tool here.  Then run the setup application.  The software is compatible 

with Windows 7, 8, 10. 

2.2 Launching the Software 

1. Open the Sensor Evaluation Tool from the Start menu of the connected computer. By default the 

software launches in the 4 sensor single-pixel view. If a device has been connected before launching the 

software, go to step 4. 

 

Figure 1 – Multiple Single-Pixel Sensor View (Default) without a Connected Device 
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2. Connect the device to the PC. 

3. Select Rescan Ports from the Device menu.  

 

Figure 2 – Rescan Ports 

4. The name of the device appears in the Device menu. Click on the device to complete the connection. 

 

Figure 3 – Connected to Device 

5. A warning message “Master device has no channels enabled” is displayed.1 This implies no data will be 

streaming as the clk and sync outputs of the master will be inactive when no data is being recorded. No 

data will be streamed until the channels have been enabled on the master (by default, Sensor 1 is the 

master, but this can be changed in the AFE register settings).2 

 

Figure 4 – Device Connected - No Channels Active 

6. Click on the OK button.  

 

 

 

 

1 This message is not displayed if the sensors have been used previously or if a default configuration file exists. 
2 There can only be one master device for surface mounted devices. If there is more than one master then the slaves receive multiple clock and sync signals and this 
causes interference in the slave output resulting in a noisy signal. 

http://www.kemet.com/


 Sensor Evaluation Tool Software  

 

The above information is believed to be correct but does not purport to be all inclusive and must be used only as a guide.   

© KEMET Electronics Corporation • KEMET Tower • One East Broward Boulevard 

Fort Lauderdale, FL 33301 USA • 954-766-2800 • www.kemet.com                 5 

 

3 4-SENSOR SINGLE-PIXEL VIEW 

With four sensors connected to the backplane board the following window is displayed. 

 

Figure 5 – Sensor Evaluation Tool Window Before Sensors Have Been Enabled 

1. Input values as required into the CCP Register for the sensor.3 

 

Figure 6 – Changing CCP Register Settings Directly 

 

3 These textboxes represent the bits of the registers. The input must be zeroes and ones (binary characters) and will be interpreted as a byte regardless of how many 
characters have been input. For example, 111 is interpreted as 00000111. Entries are treated as the least significant bits of the whole byte.  
When changing registers directly please refer to the SMD Sensor Reference Manual; this explains the meaning of each bit in the registers. Any change to a register setting 
is not implemented until the Apply button has been clicked. If a new setting has not been applied it is shaded grey, as shown in Figure 6. 
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2. Click on the Apply button for the sensor. Check that a signal is displayed. 

 

Figure 7 – Changing CCP Register Settings Directly - No Saturation 

3.1 Sensor Configuration Settings 

For more detailed information about the CCP, AFE or WUP settings, click on the cogs adjacent to the register 

settings. Changes are not implemented until the Apply button has been clicked. If a modified text field has 

not been applied, the box is shaded grey.4 

            

Figure 8 – CCP Cog Single-Pixel Sensor View Sensor 1 

 

4 Please refer to the SMD Sensor Reference Manual for information about these registers and their settings. 
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Figure 9 – AFE Cog Single-Pixel Sensor View Sensor 1 

           

Figure 10 – WUP Cog Single-Pixel Sensor View Sensor 1 

3.2 Saturation 

Sometimes when the device is first started it will saturate for a period of time before it settles. This can take 

up to 10 seconds to stop. Typical saturation events are shown in the figure below.  If the sensors are 

uncovered, and the gain and transconductance setting are set to maximum, signal saturation due to air flow 

is likely. 

 

Figure 11 – Changing CCP Registers Directly – Saturation and Warning Message for CSV Capture 

If saturation occurs during a csv file writing operation (see Section 6), a warning dialog is displayed. Click on 

the Stop Capture button to cancel the recording of data. The dialog also offers the option to suppress the 

saturation warning message in future. 

When a saturation event occurs, “Saturation Occurred”, is added to the file name and the saturated values 

are changed to 65535 in the appropriate data column. This ensures that the event is easy to identify when 

viewing files. It also allows any analysis to be easily accomplished without having to do any pre-processing 

of the data. 

http://www.kemet.com/
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3.3 Multiple Sensor Single-Pixel Views 

The Sensor Evaluation Tool detects sensors when the device is connected to the PC and adjusts the display 

accordingly.5  

 

 

 

Figure 12 – 1 (Top), 2 (Middle) and 3 (Bottom) Sensor Single-Pixel Views 

 

5 Sensors must be connected in numerical order. For example, if you want to use two sensors ensure they are placed in positions 1 and 2. 
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3.4 Programming Modes 

By default, Single Device programming mode is selected. In this mode the settings for all sensors can be 

set independently. To apply the same register settings on all the devices select the All Devices check box. 

In this mode, if the settings for any of the sensors are changed then the setting for all other sensors are also 

changed. 

For example, clicking Apply for Sensor 2, after making changes to Sensor 2, will apply the changes to all the 

sensors. Clicking Apply for any of the other sensors will update all the sensors to the settings of that sensor, 

not the changed settings of Sensor 2. 

This does not apply to the master/slave bit, as only one sensor can be the master. Single device mode must 

be used to change the master to a different device. 

                 

Figure 13 – Single Devices and All Devices Programming Modes 

If one of the configuration cogs is clicked while All Devices mode is active, Single Device programming 

mode is set automatically. Apply changes to the configuration form (see Section 3.1) as required. To apply 

these changes to all sensors, select All Devices and then click the Apply button for the sensor. 

3.5 Saving and Loading Settings 

Click on the Save button to save the current settings for all sensors. To restore settings saved previously, 

click on the Load button, and then browse to the required file. 

http://www.kemet.com/
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4 SINGLE 2X2 PIXEL VIEW 

When the software starts, it displays a set of registers for each connected device (up to four). With a 2x2 

array sensor (a single device incorporating 4 pixels) connected, the Sensor Evaluation Tool initially displays 

only one set of registers.  

 

Figure 14 – Sensor Evaluation Tool with 2x2 Sensor Array Connected 

To display registers for each channel in the array, select Single 2x2 Array Sensor View from the View menu. 

 

Figure 15 – Selecting Single 2x2 Array Sensor View 

http://www.kemet.com/
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In Single 2x2 Array Sensor View, the text above each scope states which channel is being displayed. In 

Multiple Single-Pixel Sensors View, the pixel is always attached to Channel 2. 

 

Figure 16 – Single 2x2 Array Sensor View in Single Channel Programming Mode 

In this view, the available programming modes are Single Channel or All Channels. With All Channels 

selected, the register boxes for channels 2, 3 and 4 are greyed and disabled with the settings from Channel 

1 applying to all channels. Click on the Apply button to confirm any changes to the register settings. 

 

Figure 17 – Single 2x2 Sensor View - All Channels Programming Mode 

http://www.kemet.com/
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4.1 Register Control Settings 

Click on the cog adjacent to the CCP Register settings to display the Register Control dialog box. If All 

Channels mode was enabled, Single Channel programming mode is disabled, and the registers can now 

be programmed independently. In Single Channel programming mode, only Channel 2 settings are displayed, 

and these apply to all four sensors. 

 

Figure 18 – Single 2x2 Sensor View - CCP Register Control Dialog Box 

5 EXPERT VIEW 

For a more detailed view of the sensor and additional options select Expert View from the View menu.  

 

Figure 19 – Opening Expert View 

 

Figure 20 – Expert View 
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Use Expert View to put the device into Sleep Mode, edit the scopes and assign device channels to them, and 

to control an emitter, if one is connected. The emitter controls are always displayed even if no emitter board 

is connected (there is no feedback from the board for the software to ascertain if a connection is present). 

There are two tabs: Scope Settings and Sensor Devices. 

5.1 Sleep Mode 

Use the Sensor Evaluation Tool to put a device into Sleep Mode. However, the software does not allow the 

device to be subsequently forced to wake up. It is therefore important that the Sleep Mode WUP registers are 

manually set to values that allow a wake up condition to be met before the device is put into Sleep Mode. 

Please refer to the SMD Sensor Reference Manual for details. 

To put a device into Sleep Mode, click on the Go To Sleep button. 

5.2 Wake Up Settings 

For valid wake up settings, the UHT and ULT cannot be set to the same value, the LHT and LLT cannot be 

set to the same value, the thresholds cannot be set to the maximum and minimum values. The WUT threshold 

must be set to at least the minimum number of samples. 

 

Figure 21 – Valid LHT, LLT, UHT and ULT Settings 

If these conditions are not met, the following warning message is displayed. 

 

Figure 22 – Wake Up Settings Warning Message 
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5.3 Scope Settings 

Use the Chart Control settings to configure the X and Y scales and grid spacing on the four scopes. Select 

the channels to be displayed by the four scopes using the Scope 1, Scope 2, Scope 3 and Scope 4 

dropdown boxes. 

 

Figure 23 – Scope Settings Showing the Dropdown Device List for Scope 1 

5.4 Sensor Devices 

This tab shows the Emitter Control settings. The graphic on the right hand side shows which of the devices 

is currently active and editable on the tab. The active registers are shown in green. Click on another device 

(for example, U4) to update the tab with that device’s register settings. 

      

Figure 24 – Sensor Devices Tab in Single Device Programming Mode with U1 (Left) and U4 (Right) Settings Selected 

By selecting the All Devices programming mode, all the sensor graphics are coloured green and the text 

boxes display the last individually selected device. 

http://www.kemet.com/
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Figure 25 - Sensor Devices Tab - All Devices Programming Mode 

5.5 Register Control in Expert View 

 

Figure 26 – CCP Register - Detailed View 

In Expert View, the Register Control dialog boxes (displayed by clicking on the cog buttons) display 

descriptions of the registers in the same way with the exception of the CCP Register. This is because the 

single-pixel sensor view is designed for sensors with a single-pixel. Therefore most of the CCP registers are 

not required. However, in Expert View no assumption is made about pixel numbers and the additional 

registers are displayed. 

6 SAVING DATA TO CSV FILE 

To save data, select Save to CSV from the File menu.  

 

Figure 27 – Save to CSV 

http://www.kemet.com/


 Sensor Evaluation Tool Software  

 

The above information is believed to be correct but does not purport to be all inclusive and must be used only as a guide.   

© KEMET Electronics Corporation • KEMET Tower • One East Broward Boulevard 

Fort Lauderdale, FL 33301 USA • 954-766-2800 • www.kemet.com                 16 

 

The Capture Data to CSV File dialog box is displayed.  

 

Figure 28 – Save to CSV Clicked 

Enter the full address path to which the file should be written or browse to the required folder. By default, files 

are saved to the “KEMET” folder if it exists or “My Documents” if it does not. The “KEMET” folder is created 

automatically in the Documents folder the first time the user saves a configuration file. 

Choose options for the way data is to be captured. The options are to: 

• Capture data Indefinitely: Save data until Stop CSV Capture is selected from the File menu. 

• Number of sample to capture: Save a specific number of samples according to the sampling rate 

set in CSV File Options. 

• Capture time ms: Record data for a set time interval (in milliseconds). 

6.1 Data Sampling Rates 

1. Choose CSV File Options from the File menu to set the timing interval for data sampling. 

 

Figure 29 – CSV Options Clicked 

2. Select the Use Timing Options checkbox. 

 

Figure 30 – Enabling CSV Options 

http://www.kemet.com/
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3. Input values for: 

• Time period between data records: the delay between consecutive data samples 

• Time duration per record (Seconds): the time of each record.6  

   

Figure 31 – Applying Data Sampling Times 

4. Click on the Apply button. 

Invalid timing options result in a warning message being displayed. If this occurs, correct the settings, and 

reapply. 

 

Figure 32 – CSV Options Error Message 

7 SAVING AND LOADING CONFIGURATION FILES 

There are two options for saving the current settings in configuration files: 

• Save: Create and save the configuration in a text file in any location (“Documents\KEMET” if 

unspecified). 

• Save Default: As above, but also create or overwrite the default configuration file applied whenever 

the software initially connects to a device. This file has the name “default.txt” and is located in the 

“Documents\KEMET\Sensor Evaluation Tool” folder. 

7.1 Saving Settings 

To save the current set of register settings for future use:  

 

 

 

 

 

 

6 The duration of each record cannot be greater than or equal to the delay between consecutive records. 
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1. Click on the Save button. 

 

Figure 33 – Save and Load Buttons 

2. A Save As dialog box is displayed. By default, files are saved in a folder called “KEMET” in the 

“Documents” folder. 

 

Figure 34 – Saving Settings - Doc Title 

3. Enter a suitable file name for the settings. The settings file is saved as a text file (.txt extension). 

4. Click on the Save button. 

 

http://www.kemet.com/
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7.2 Saving the Default Configuration 

Click on the Save Default button to update the default configuration used by the software. You are given the 

option to save the configuration under another filename as described in the previous section. When 

confirmed, a second version of the configuration is saved as “default.txt’ in the “Documents\KEMET\Sensor 

Evaluation Tool” folder. If the file already exists, it is overwritten. The default configuration file is applied to a 

device whenever the software first connects to it.  

7.3 Loading Settings 

To apply a previously saved set of registry settings: 

1. Click on the Load button 

2. An Open dialog box is displayed. 

 

Figure 35 – Load Settings - Select File 

3. Select the required settings file. 

4. Click on the Open button. The register settings are applied to the currently active device(s).7 

8 ABOUT  

Click on About in the menu bar to display file and version information about the Sensor Evaluation Tool 

software. 

 

Figure 36 – About Box 

 

7 Configuration files are specific for the number of devices used: for example, a configuration file for 2 sensors will not work for 1, 3 or 4 sensors. 

http://www.kemet.com/


 Sensor Evaluation Tool Software  

 

The above information is believed to be correct but does not purport to be all inclusive and must be used only as a guide.   

© KEMET Electronics Corporation • KEMET Tower • One East Broward Boulevard 

Fort Lauderdale, FL 33301 USA • 954-766-2800 • www.kemet.com                 20 

 

9 LIST OF ABBREVIATIONS 

AFE Analog Front End 

CCP Channel Control Packet 

CSV Comma Separated Values 

HPF High Pass Filter 

LHT Lower High Threshold  

LLT Lower Low Threshold 

LPF Low Pass Filter 

WT Wake-Up Time Threshold 

WUP Wake-Up Packet 

UHT Upper High Threshold 

ULT Upper Low Threshold 
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